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Warranty 

All products manufactured by ICP DAS are under warranty regarding 

defective materials for a period of one year, beginning from the date of 

delivery to the original purchaser. 

 

Warning 

ICP DAS assumes no liability for any damage resulting from the use of this 

product. ICP DAS reserves the right to change this manual at any time 

without notice. The information furnished by ICP DAS is believed to be 

accurate and reliable. However, no responsibility is assumed by ICP DAS for 

its use, not for any infringements of patents or other rights of third parties 

resulting from its use. 

 

Copyright 

Copyright @ 2017 by ICP DAS Co., Ltd. All rights are reserved. 

 

Trademark 

The names used for identification only may be registered trademarks of 

their respective companies. 

 

 

Contact US 

If you have any problem, please feel free to contact us. 

You can count on us for quick response. 

 

   Email: service@icpdas.com 
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1. Introduction 

This chapter provides an overview of the VP-x231-CE7 and its components, and introduces the 

fundamental concepts for user familiar with the VP-x231-CE7. 

 

 

 

The VP-x231-CE7 is the new generation Windows CE 7.0 based PAC (Programmable Automation 

Controller) of ICP DAS. Each VP-x231-CE7 is equipped with a Cortex-A8 (1.0 GHz) CPU running a 

Windows CE 7.0 operating system, a variant of input/output ports (VGA, USB, Ethernet, 

RS-232/485), and 3 expansion I/O slots that can be used to integrate high performance I-8K 

(parallel-type) and I-87K (serial-type) series I/O modules.   

 

Its operating system, Windows CE 7.0, has many advantages, including hard real-time capability, 

small core size, fast boot speed, and interrupt handling at a deeper level, achievable deterministic 

control and low cost. Using Windows CE 7.0 in the VP-x231-CE7 gives it the ability to run PC-based 

Control software such as Visual Basic.NET, Visual C#, Embedded Visual C++, SCADA software, Soft 

PLC …etc. 
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1.1. Features 

The VP-x231-CE7 offers the most comprehensive configuration to meet specific application 

requirements. The following list shows the hardware and software features designed to simplify 

installation, configuration and application. 

 

 

Hardware Features 

 Powerful CPU module 

 Cortex-A8 1.0 GHz CPU 

 Memory Size: 

- SDRAM (512 MB) 

- MRAM (128 KB) 

- Flash (256 MB) 

- FRAM (64 KB) 

- microSD card (support up to 32 GB) 

 VGA Port x 1, USB 2.0 port x 1, Series port (RS-232/RS-485) x 2 

 64-bit Hardware Serial Number 

 Dual Watchdog Timers 

 Operating Temperature: -25 ~ +75 °C 

 

 

 

Software Features 

 Windows Embedded Compact 7.0 

 JavaScript and VBScript 

 SQL Compact Edition 3.5 

 .NET Compact Framework 3.5 

 Remote Display 

 Rich Software Solution – SDK for Microsoft Studio 2008 
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1.2. Specifications 

The table below summarizes the specifications of the VP-x231-CE7. 

Models VP-1231-CE7 VP-4231-CE7 VP-6231-CE7 

System Software 

OS Windows CE 7.0 

.Net Compact Framework 3.5 

Embedded Service 
FTP Server, Web Server (Supports VB script, JAVA script), Embedded 

SQL Server 

SDK Provided Dll for VC, Dll for Visual Studio.Net 2008                                                                                               

Multilanguage Support 
English, German, French, Spanish, Russian, Italian, Korean, 

Simplified Chinese, Traditional Chinese 

CPU Module 

CPU Cortex-A8 (32-bit and 1.0 GHz) 

SDRAM 512 MB (DDR3) 

MRAM 128 KB 

Flash 256 MB 

EEPROM 16 KB 

microSD microSD socket with one microSD card (support up to 32 GB) 

RTC (Real Time Clock) Provide second, minute, hour, date, day of week, month, year 

64-bit Hardware Serial Number Yes, for software copy protection 

Dual Watchdog Timers Yes (0.8 second) 

LED Indicator 

3 Dual-Color LEDs 

(PWR, RUN, LAN1, 

L1, L2, L3; L1 to L3 

for user 

programmable) 

2 Dual-Color LEDs (PWR and RUN) 

Rotary Switch Yes (0 to 9) 

LCD Display 

Size 5.7” (4:3) 10” (4:3) 15” (4:3) 

Resolution 640 x 480 800 x 600 1024 x 768 

Brightness 400 350 

Contrast Ratio 250:1 500:1 

LED Backlight Life (hrs) 20,000 

Touch Panel 

4-wire, resistive 

type; light 

transmission: 80 % 

5-wire, resistive type;  

light transmission: 80 % 
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Communication Interfaces 

Ethernet RJ-45 x 1, 10/100/1000 Base-TX 

USB 2.0 (host) 1 2 

COM 2 RS-485 (D+, D-; self-tuner ASIC inside); 2500 VDC isolated 

COM 3 
RS-232 (RxD, TxD, CTS, RTS, DSR, DTR, CD, RI and GND); 

Non-isolated 

Audio 
Mic-in and 

Earphone-out 
Earphone-out 

Mic-in and 

Earphone-out 

I/O Expansion Slots 

Number of I/O slots 3 

Supported types of I/O modules I-8K and I-87K series I/O Modules 

Mechanical 

Dimensions (W x H x D), unit: mm 182 x 158 x 125 291 x 229 x 129 381 x 305 x 145 

Panel Cut-out, unit: mm 153 x 136 + 1.0 276 x 214 + 1.0 366 x 290 + 1.0 

Ingress Protection Front panel: IP65 

Installation Panel mounting 

Environmental 

Operating Temperature -20 °C to +70 °C 

Storage Temperature -30 °C to + 80 °C 

Ambient Relative Humidity 10 % to 90 % RH (non-condensing) 

Power 

Input Range +10 VDC to +30 VDC 

Redundant Power Inputs - Yes 

Isolation 1 kV 

Consumption 0.3 A @ 24 VDC 0.45 A @ 24 VDC 0.65 A @ 24 VDC 
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1.3. Overview 

The VP-x231-CE7 is equipped with several interfaces and peripherals that can be integrated with 

external systems. Here is an overview of the components and its descriptions.  

 

 

VP-1231-CE7 
 

Front View                                Side View              

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Back View                                            
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● LED Indicators 

The VP-1231-CE7 has 3 Dual-Color LED indicators. The details of these LED indicators are as 

follows: 

 

 

 

 

 

LED Indicator Color Status Description 

L1/L2/L3 
Red On 

LED indicators controlled by user Program. 
Red Off 

RUN 

Green On System booted and ready. 

Green Off BIOS failure. 

Green Blinking 
System memory mapped out, formatted or 

defragmented. 

PWR 
Green On System has power applied to it. 

Green Off System is not powered on. 

LAN1 

Green On Link between system and network. 

Green Off Network disconnected. 

Green Blinking Network Access. 

 

 

● Touch Screen 

The VP-1231-CE7 is equipped with a touch screen to touch and change the settings.  

 

 

● Programmable Function Keys 

The VP-x231-CE7 provides support for keyboard input. The F1 to F6 function keys can be 

programmed by the user. 

 

 

● Rotary Switch 

Rotary Switch is an operating mode selector. The VP-x231-CE7 has several operating 

modes, for more detailed information about these operating modes. Please refer to 

“2.2. Configuring the Boot Mode” 
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● I/O Slots 

The VP-x231-CE7 has 3 I/O slots that can be used to integrate high performance parallel I/O 

modules (high profile I-8K Series) or serial I/O modules (high profile I-87K series). 

 

 

● Power Input and Frame Ground 

The VP-x231-CE7 has a terminal with 3pins, there are 2 pins for power input and a pin for frame 

ground as follows: 

 

 

 

 

 

 

 

 

 

 

 

 

● Ethernet Port 

The VP-x231-CE7 has an Ethernet port that can be used to connect that can be used to connect 

the router to the Internet or to other devices. 

 

 

● Mic-in and Earphone-out 

The VP-x231-CE7 has a microphone and an earphone jack to the input and output of sound 

system. 

 

 

● USB Port 

The VP-x231-CE7 has a USB 2.0 port that can be used to connect the USB devices such as mouse, 

keyboard or an external USB hard drive.  
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● COM2 

COM2 port provides a connection to external RS-485 devices. The COM2 has 2 pins, as follows: 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 

 

 

● COM3 

The VP-x231-CE7 has one standard RS-232 serial communication interface port, COM3 (9-pin 

Sub-D plug connector). The details of this Pin assignment are as follows: 

Port Type: Male 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 5, 6, 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 
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VP-4231-CE7/CP-6231-CE7 
 

Front View                             Side View                         

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Rear View                                                               

 

 

 

 

 

 

 

 

 

 

 

VP-4231-CE7 

VP-6231-CE7 VP-4231-CE7 

VP-6231-CE7 
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● LED Indicators 

The VP-4231-CE7/VP-6231-CE7 has 2 Dual-Color LED indicators. The details of these LED 

indicators are as follows: 

 

 

 

 

 

LED Indicator Color Status Description 

RUN 
Red On Booting 

Red Off System booted and OS ready 

PWR 
Green On System has power applied to it 

Green Off System is not powered on 

 

 

● Touch Screen 

The VP-4231-CE7/VP-6231-CE7 is equipped with a touch screen to touch and change the 

settings.  

 

 

● SD Socket 

The SD socket can be used to restore the VP-4231-CE7/VP-6231-CE7 system and expand the 

memory up to 32 GB. 

 

 

● USB Host Port 

The USB host port allows you to connect a USB–compatible mouse, keyboard, or other 

plug-and-play peripherals and direct communication between data acquisition system and USB 

storage device. 

 

 

● Rotary Switch 

Rotary Switch is an operating mode selector. The VP-x231-CE7 has several operating 

modes, for more detailed information about these operating modes. Please refer to 

“2.2 Configuring the Boot Mode” 
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● I/O Slots 

The VP-4231-CE7/VP-6231-CE7 has 3 I/O slots that can be used to integrate high performance 

parallel I/O modules (high profile I-8K Series) or serial I/O modules (high profile I-87K series). 

 

 

● Power Input and Frame Ground 

The VP-4231-CE7/VP-6231-CE7 has a terminal with 5 pins, there are 4 pins for redundant power 

inputs and a pin for frame ground as follows: 

 

 

 

 

 

 

 

 

 

 

 

● Ethernet Port 

The VP-4231-CE7/VP-6231-CE7 has an Ethernet port that can be connected to a 

computer or device via an Ethernet cable. 

LED Indicator Color Status Description 

100M/1G 
Orange On Network Speed: 1 G 

Orange Off Network Speed: 10/100 M 

Link/Act 

Green On The Link is active 

Green Off The Link is inactive 

Green Blinking Network activity 

 

 

● Earphone-out/Mic-in and Earphone-out 

The VP-4231-CE7/VP-6231-CE7 has an earphone/a microphone and an earphone jack to the 

input/input and output of sound system. 

 

 

 

VP-6231-CE7 VP-4231-CE7 
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● USB Port 

The VP-4231-CE7/VP-6231-CE7 has 2 USB 2.0 port that can be used to connect the USB devices 

such as mouse, keyboard or an external USB hard drive.  

 

 

● COM2 (RS-485) 

COM2 port provides a connection to external RS-485 devices. The COM2 has 2 pins, as follows: 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 

 

 

● COM3 (RS-232) 

The VP-x231-CE7 has one standard RS-232 serial communication interface port, COM3 (9-pin 

Sub-D plug connector). The details of this Pin assignment are as follows: 

Port Type: Male 

Baud Rate: 115200, 57600, 38400, 19200, 9600, 4800, 2400, 1200 bps 

Data Bits: 5, 6, 7, 8 

Parity: None, Even, Odd, Mark (Always 1), Space (Always 0) 

Stop Bits: 1, 2 

FIFO: 16 bytes 
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1.4. Dimensions 

The diagrams below provide the dimensions of the VP-x231-CE7 to use in defining your enclosure 

specifications. Remember to leave room for potential expansion if you are using other components 

in your system. 

 

 

VP-1231-CE7 
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VP-4231-CE7 
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VP-6231-CE7 
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 CD:\VP-x231\ 

Backup 

The files package for each release. 

demo 

The demo programs for examples of use in the application. 

Document 

The technical support documents for installation, operation, 

maintenance, development and application. 

Micro_SD 

The recovered files stored on the micro SD card, that can be used to 
boot and recover the system from micro SD card. 

OS_image 

The files and related information for OS releases and technology. 

PC_Tools 

The tools and utilies for operation with PC. 

SDK 

The sources for development and application in your application. 

System_Disk 

The tools and drivers related to System_Disk that install on VP-x231-CE7. 

Update 

The installation packages related to VP-x231-CE7. 

1.5. Companion CD 

This package comes with a CD that provides a collection of the software utility, documentation, 

drivers, demo program and application. The CD contains several subdirectories located in \VP-x231 

directory. All of them are listed below. 
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2. Getting Started 

This chapter provides a guided tour of the VP-x231-CE7 installation and configuration that 

describes the steps needed to download, install, configure, and run the basic procedures for user 

working with the VP-x231-CE7 for the first time. 

 

 

 

2.1. Mounting the VP-x231-CE7 

Before you work with the VP-x231-CE7, you should have a basic understanding of hardware 

specification, such as the dimensions, the usable input-voltage range of the power supply, and the 

type of communication interfaces. 

 

For more information about the hardware details, see section 1.2., “Specifications.” 

For more information about the hardware dimensions, see section 1.4., “Dimensions.” 

 

By hardware mechanism, the VP-x231-CE7 installation guide is divided into two sections, as 

follows: 

1. For VP-1231-CE7 – section 2.1.1. VP-1231-CE7 Installation 

2. For VP-4231-CE7 – section 2.1.2. VP-4231-CE7 Installation 

3. For VP-6231-CE7 – section 2.1.3. VP-6231-CE7 Installation 
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2.1.1. VP-1231-CE7 Installation 

Here is a brief of the steps to install the VP-1231-CE7. 

 

 

2.1.1.1. Checking the Package Contents 

Before starting any task, please check the package contents. If any of the following package 

contents are missing or damaged, contact your dealer, distributor. 

 

 

 

 

 

VP-1231-CE7 

  

RJ-45 Waterproof Assembly 

 A microSD Card and a microSD 

to SD Adapter 

 

 

 

 

Touch Pen 

  

Software Utility CD 

  

Screw Driver 

 

 

 

 

Panel clip * 4  M4 x 30L Screw * 4   
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2.1.1.2. Inserting the I/O Modules 

There is a top case on each I/O socket. Before inserting the I/O module you first need to remove it. 

 

 

Step 1: Unlock the top case of the I/O 
slot and then remove it 

 

 

 

 

Step 2: Hold the I/O module vertically and align the 
socket and then carefully press the I/O 
module onto the socket 

Step 3: Lock the I/O module 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

If you do not expand the I/O module full, please keep the top case of the 

unused slot to protect the backplane from dirt, dust and damage from 

foreign objects. 
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2.1.1.3. Installing the RJ-45 waterproof connector assembly 

The VP-1231-CE7 is equipped with an RJ-45 waterproof 

connector to protect the connection in vibrate environment. 

 

The RJ-45 waterproof connector is optional for use with 

Ethernet port. If you do not need the RJ-45 waterproof 

connector, you just plug in a regular Ethernet cable.  

 

 

 

 

 

If you want to use the RJ-45 waterproof connector for protecting the connection, follow the 

instructions below. 

Step 1: Remove the RJ-45 connector from the RJ-45 cable 

 

 

 

 

 

 

 

Step 2: Feed the end of the RJ-45 cable through the (A) sealing nut, (B) rubber sealing 
insert, (C) cable gland base, (D) clamping ring and (E) panel gasket 

 

 

 

 

 

 

 

 

 

 

 

A B C D E 
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Step 3: Wrap the (E) panel gasket around the (D) clamping ring  

 

 

 

 

 

 

 

 

 

 

 

Step 4: Wrap the (C) cable gland base around the (D) clamping ring  

 

 

 

 

 

 

 

 

 

 

Step 5: Insert the (B) rubber sealing insert into the (D) clamping ring 
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Step 6: Push the (E) sealing nut forward and Hand-tighten it to seal the assembly 

 

 

 

 

 

 

 

 

 

 

 

 

Step 7: Insert the RJ-45 cable into the RJ-45 connector 

 

 

 

 

 

 

 

 

 

 

 

Step 8: Push the RJ-45 waterproof connector ass grabembly forward 
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Step 9: Insert the Ethernet cable and screw the RJ-45 waterproof into the receptacle 

 

 

 

 

 

 

 

 

The Ethernet cable is secured tightly 
in the connector. 
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2.1.1.4. Mounting the VP-1231-CE7 

The VP-1231-CE7 can be mounted on a panel of maximum thickness 12 

mm. Adequate access space can be available at the rear of the 

instrument panel for wiring and servicing purposes. 

 

 

Tips & Warnings 

To ensure proper ventilation for the VP-1231-CE7, 

leave a minimum of 50 mm space between the 

top and bottom edges of the VP-1231-CE7 and 

the enclosure panels. 

 

 

 

Step 1: Prepare the panel and cut the hole to the 
specified size 

 

Step 2: Attach the VP-1231-CE7 to the cut-out hole 
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Step 3: Insert the panel mounting clips into the upper and lower ventilation holes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: Screw the panel mounting clips to the panel. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

Recommended Screw Torque:  3.4 ~ 4.5 kgf-cm. 
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2.1.1.5. Deploying a Basic VP-1231-CE7 System 

The VP-1231-CE7 provides a variety of communication interface to suit a range of application. Here 

is a simple application for using the VP-1231-CE7. 

 

Step 1: Connect the positive terminal (+) of the power supply to the terminal PWR1/2 
and the negative terminal (-) of the power supply to the P.GND 

Step 2: Connect the USB mouse or the USB keyboard to the USB port 

Step 3: Connect the monitor to the VGA port 

Step 4: Connect to PC or the laptop to the LAN port via an Ethernet switch 
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2.1.2. VP-4231-CE7 Installation 

Here is a brief of the steps to install the VP-4231-CE7. 

 

 

 

2.1.2.1. Checking the Package Contents 

Before starting any task, please check the package contents. If any of the following package 

contents are missing or damaged, contact your dealer, distributor. 

 

 

 

 

 

VP-4231-CE7  

A microSD card and a micro 

SD/SD adapter  Software Utility CD 

 

 

 

 

 

 

 

Touch Pen  Screw Driver  Panel Clip * 4  M4 x 30L Screw * 4 
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2.1.2.2. Inserting the I/O Modules 

There is a top case on each I/O socket. Before inserting the I/O module you first need to remove it. 

 

 

Step 1: Unlock the top case of the I/O 
slot and then remove it 

 

 

 

 

Step 2: Hold the I/O module vertically and align the 
socket and then carefully press the I/O 
module onto the socket 

Step 3: Lock the I/O module 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

If you do not expand the I/O module full, please keep the top case of the 

unused slot to protect the backplane from dirt, dust and damage from 

foreign objects. 
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2.1.2.3. Mounting the VP-4231-CE7 

The VP-4231-CE7 can be mounted on a panel of maximum thickness 5 mm. 

Adequate access space can be available at the rear of the instrument panel 

for wiring and servicing purposes. 

 

 

Tips & Warnings 

To ensure proper ventilation for the VP-4231-CE7, leave a 

minimum of 50 mm space between the top and bottom 

edges of the VP-4231-CE7 and the enclosure panels. 

 

 

 

 

Step 1: Prepare the panel and cut the hole to the 
specified size 

 

 

 

 

Step 2: Attach the VP-4231-CE7 to the cut-out hole 
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Step 3: Insert the panel mounting clips into the upper 
and lower ventilation holes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: Screw the panel mounting clips to the panel 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

Recommended Screw Torque:  3.4 ~ 4.5 kgf-cm. 
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2.1.2.4. Deploying a Basic VP-4231-CE7 System 

The VP-4231-CE7 provides a variety of communication interface to suit a range of application. Here 

is a simple application for using the VP-4231-CE7. 

 

Step 1: Connect the positive terminal (+) of the power supply to the terminal PWR1/2 
and the negative terminal (-) of the power supply to the P.GND 

Step 2: Connect the USB mouse or the USB keyboard to the USB port 
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2.1.3. VP-6231-CE7 Installation 

Here is a brief of the steps to install the VP-6231-CE7. 

 

 

2.1.3.1. Checking the Package Contents 

Before starting any task, please check the package contents. If any of the following package 

contents are missing or damaged, contact your dealer, distributor. 

 

 

 

 

 

VP-6231-CE7 

  

I/O Socket * 3 

 A microSD Card and a 

microSD to SD Adapter 

 

 

 

 

Touch Pen 

  

Software Utility CD 

  

Screw Driver 

 

 

 

 

Panel clip * 4  M4 x 30L Screw * 4   
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2.1.3.2. Inserting the I/O Modules 

There is a top case on each I/O socket. Before inserting the I/O module you first need to remove it. 

 

 

 

 

Step 1: Use the screw driver to remove the screw 
and then remove the top case 

 

 

 

 

 

 

 

 

 

Step 2: Hold the I/O socket vertically and align the VP-4231-CE7 socket and then carefully 
press the I/O socket onto the socket 

 

 

Step 3: Use screw driver to screw 
tightly the screw 
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Step 4: Hold the I/O module vertically and align the socket and then carefully press the 
I/O module onto the socket 

 

 

Step 5: Lock the I/O module 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

If you do not expand the I/O module full, please keep the top case of the 

unused slot to protect the backplane from dirt, dust and damage from 

foreign objects. 
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2.1.3.3. Mounting the VP-6231-CE7 

The VP-6231-CE7 can be mounted on a panel of maximum thickness 5 mm. 

Adequate access space can be available at the rear of the instrument panel 

for wiring and servicing purposes. 

 

 

Tips & Warnings 

To ensure proper ventilation for the VP-6231-CE7, leave 

a minimum of 50 mm space between the top and bottom 

edges of the VP-6231-CE7 and the enclosure panels. 

 

 

 

 

 

 

Step 1: Prepare the panel and cut the 
hole to the specified size 

 

Step 2: Attach the VP-6231-CE7 to the 
cut-out hole 
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Step 3: Insert the panel mounting clips into the upper 
and lower ventilation holes 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: Screw the panel mounting clips to the panel. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

Recommended Screw Torque:  3.4 ~ 4.5 kgf-cm. 
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2.1.3.4. Deploying a Basic VP-6231-CE7 System 

The VP-6231-CE7 provides a variety of communication interface to suit a range of application. Here 

is a simple application for using the VP-6231-CE7. 

 

Step 1: Connect the positive terminal (+) of the power supply to the terminal PWR1/2 
and the negative terminal (-) of the power supply to the P.GND 

Step 2: Connect the USB mouse or the USB keyboard to the USB port 
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2.2. Configuring the Boot Mode 

The VP-x231-CE7 has several operating modes, which can be selected by a rotary switch. 

 

 

 

 

 

 

 

 

 

 

 

 

The table below lists the operation modes available with the VP-x231-CE7. 

Position Operating Mode 

0 Normal mode (Default) 

1 Safe mode 

2 Debug mode 

3 OS update mode by Ethernet 

4 Reserve 

5 OS update mode by Micro_SD  

6 Reserve (OS Development Mode) 

7 ~ 9 User Mode 

 

 

 

The following is a brief introduction of these modes. 

 

 

Normal Mode (Default mode) 

Normal mode is the default mode of operation and the one you will use most of the 

time. Use this mode for more tasks and configurations. Programs also are executed in 

this mode. 
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Safe Mode 

Safe mode is a trouble shooting. The mode loads the minimum required device 

drivers and system services to boot the VP-x231-CE7. 

If you have malicious software or a program caused the VP-x231-CE7 cannot be boot 

or run the normal mode, you can boot in safe mode to solve the problem. 

 

 

Debug Mode 

Debug mode is a special environment in which program debug functions can be used 

in addition to normal system functions. 

Debug mode is unsupported. 

 

 

OS Update Mode 

OS update mode is a way used to update OS. For more information on updating the 

VP-x231-CE7 OS image, please refer to section 6.1. OS updates 

 

 

Reserve → OS Development Mode 

The positions 4, 6, of rotary switch are reserved for OS development. 

 

 

User Mode 

The positions 7, 8, 9 of rotary switch are reserved for user’s applications. 

When VP-x231-CE7 is boot with one of these positions, it is boot at normal mode. 

User’s application can check the position of the rotary switch position to run at 

different mode. 
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2.3. Changing the User Interface Language  

The Regional and Language Settings is a Windows CE functionality that allows users to change the 

VP-x231-CE7 user interface with your native language. 

 

 

 

Step 1: Click Start menu, point to Settings, click Control Panel, and then click Regional 
Settings 
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Step 2: Click User Interface Language tab, choose to your local language, and then click 
OK button 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3: Double-click the PAC Utility on the desktop, and then reboot the VP-x231-CE7 for 
changes to take effect 
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2.4. Using PAC Utility to Manage the VP-x231-CE7 

The PAC Utility is a collection of the VP-x231-CE7 system tool that allows users to manage and 

configure the VP-x231-CE7 quickly and easily. 

 

For more detailed information on PAC Utility applications, please refer to “3.1. PAC Utility” 

 

Step 1: Double-click the PAC Utility on the desktop 

Step 2: Configure IP address (DHCP), FTP Server, Auto Execution files…, etc 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Step 3: Reboot the VP-x231-CE7 
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2.5. Using DCON Utility Pro Configure I/O Modules 

DCON Utility Pro allows users to configure and manage the I/O modules via Ethernet or serial ports 

(RS-232/RS-485). 

 

Step 1: Double-click the DCON_Utility_Pro on the desktop 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Click the         button 
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Step 3: Configure the communication settings 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

The COM port settings for expansion I/O modules are listed below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

COM2/3 

For more information on these COM port selections, please refer to the 

specification of the pin assignments in section 1.3. Overview 

COM0 [Backplane] 
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Step 4: Click the         button 

Step 5: Click the module name to configure the I/O module 
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3. Tools and Tasks 

This chapter provides a brief introduction of theVP-x231-CE7 service tools and its benefits. 

 

There are several tools and utilities built-in and designed for use with VP-x231-CE7. Some of these 

are pre-installed on VP-x231-CE7 and can work directly on VP-x231-CE7, and some of these are 

supporting tools and can help you to manage the VP-x231-CE7 remotely on a PC. 

 

The following tools are pre-installed on VP-x231-CE7 and can work directly on VP-x231-CE7 that 

can be found on the CD that was provided with the package or by downloading the latest version 

from ICP DAS web site. 

 

 

 

 

 

 

 

 

CD:\vp-x231\System_Disk\Tools\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/system_disk/tools/ 

DCON_Utility_Pro 

ISQLW35 

modbus_master_tool 

Notepad 

PAC_Utility 

RegEdit 

Remote_Display 

SendToCOM 

TaskMgr 

VCEP 
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3.1. PAC Utility 

PAC Utility is a collection of software applications that enable management and configuration of 

VP-x231-CE7 system and features.  

PAC Utility is subject to change 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The PAC Utility includes the following menu bars and property tabs.  

All of these functions will be explained later. 

 

Menu bar Property Tab 

File 

Help 

General 

General2 

Display 

IP Config 

Network 

Device Information 

Auto Execution 

Rotary Execution 
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3.1.1. Menu Bar – File 

 

 

 

 

 

 

 

 

The menus use to How to use 

Reboot Restarts the VP-x231-CE7 

Restore Default Settings Restore the VP-x231-CE7 settings to its default. 

Exit Exits the PAC Utility. 
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3.1.2. Menu Bar – Help 

 

 

 

 

 

 

 

 

 

 

 

 

 

The menus use to How to use 

About Displays a dialog box with information about PAC Utility, 

including the current version and copyright information. 
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3.1.3. Property Tab - General 

The General tab provides functions to configure the task bar, check the status of the battery…, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Lock or Auto-Hide 

the taskbar 

Auto-Hide the taskbar:  

Select the Auto Hide check box. 

Lock the taskbar:  

Select the Always On Top check box. 

Auto save or 

manual save to 

flash 

Auto save to flash: 

Select the Auto Save To Flash (Default) check box. 

Any changes made to the VP-x231-CE7 will be saved and only take effect 

after the VP-x231-CE7 reboots.  

Manual save to flash: 

Select the Manual Save to Flash 

check box.  

Any changes made to the 

VP-x231-CE7 will be saved by 

clicking the Save and Reboot from 

File menu. 
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The tab use to How to use 

Enable USB autorun Select the Enable Autorun in plugging USB Disk check box. 

Enable microSD auotrun This item is temporarily unavailable. 

Automatic synchronization 

of system time 

Refer to the Appendix A.2. How to configure the service for 

automatically synchronizing with the internet time server. 

Adjust the backlight Move the slider to the left to decrease the brightness or move the 

slider to the right to increase the brightness, and then click the 

Save the settings button. 
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3.1.4. Property Tab – General2 

The General2 tab provides functions to specify the name of the USB disk. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Specify the name of the USB disk Enter a name in the USB Hard Disk: field 
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3.1.5. Property Tab – Display 

The Display tab provides functions to configure the monitor settings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Adjust the screen 

resolution 

Move the slider to the left to decrease the resolution or move the 

slider to the right to increase the resolution, and then click the Apply 

button. 

Change the screen 

refresh rate 

Select the desired refresh rate from the Screen refresh rate 

drop-down list, and then click the Apply button. 

 

 

 



VP-x231-CE7 User Manual, v1.0.2                    Page: 59 

Copyright ©  2017 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 
 

3.1.6. Property Tab – IP Config 

The IP Config tab provides functions to configure either DHCP (Roaming) or manually configured 

(Static) network settings and to monitor the MAC address. Generally, DHCP is the default settings, 

but if you don’t have a DHCP server, you must configure the network settings by using manual 

configuration. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Set the network 

settings 

Use DHCP to get IP address: 

Select the Use DHCP to get IP address option, and then click the Apply 

button. 

Assign an IP address: 

Select the Assign IP address option, and then click the Apply button. 
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3.1.7. Property Tab – Network 

The Network tab comprises three tabs – Access, Login and File Server Settings. 

 

 

Access 

The Access tab provides functions to enable/disable the FTP access, enable/disable anonymous 

FTP access, and configure the FTP and HTTP directory path. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Enable or disable the 

FTP access 

Enable the FTP access: 

Select the Enable check box in the FTP field, and then click the 

Apply button. 

Disable the FTP access: 

Select the Disable check box in the FTP field, and then click the 

Apply button. 
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The tab use to How to use 

Enable or disable 

anonymous FTP 

access 

Enable anonymous FTP access: 

Select the Enable check box in the Allow Anonymous field, and then 

click the Apply button. 

Disable anonymous FTP access: 

Select the Disable check box in the Allow Anonymous field, and then 

click the Apply button. 

Set the FTP 

directory path 

Enter a new path in the Set FTP default download directory to: field, 

and then click the Apply button. 

Set the HTTP 

directory path 

Enter a new path in the Set HTTP document root directory to: field, 

and then click the Apply button. 

 

 

Login 

The Login tab provides functions to maintain the FTP accounts. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Maintain the FTP 

accounts 

Refer to the Appendix C.1 How to add a user account to remote 

login the VP-x231-CE7 from PC. 

 



VP-x231-CE7 User Manual, v1.0.2                    Page: 62 

Copyright ©  2017 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 
 

File Server Settings 

The File Server Settings tab provides functions to set the SMB server. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Set the SMB server Click the Settings button to set the SMB server path. 
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3.1.8. Property Tab – Device Information 

The Device Information tab provides functions to monitor necessary system information of the 

VP-x231-CE7. The information is the most important note of version control for upgrading system. 
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3.1.9. Property Tab – Auto Execution 

The Auto Execution tab provides functions to configure programs running at VP-x231-CE7 startup, 

it allows users to configure ten execute files at most. 

 

Tips & Warnings 

The specific extensions are .exe and .bat, and they are executed in order of 

program 1, program 2, etc. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Configure programs 

running at startup 

Click the Browse button to select the execute file which you want, 

and then click the Apply button. 
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3.1.10. Property Tab – Rotary Execution 

The Rotary Execution tab provides functions to configure programs running at VP-x231-CE7 

startup in one of the user defined mode, it allows users to configure ten execute files at most. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The tab use to How to use 

Configure programs running at startup 

in one of the user defined mode 

Click the Browse button to select the execute file 

which you want, and then click the Apply button. 
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3.2. DCON Utility Pro 

DCON Utility Pro enables users easily to configure and manage the I/O modules via Ethernet or 

serial ports (RS-232/RS-485).  

 

For more information on how to use DCON Utility Pro to configure I/O modules, please refer to 2.5. 

Using DCON Utility Pro to Configure I/O Modules 

 

For more detailed information on DCON Utility application, please refer to: 

http://www.icpdas.com/root/product/solutions/software/utilities/dcon_utiltiy_pro.html 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.icpdas.com/root/product/solutions/software/utilities/dcon_utiltiy_pro.html
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3.3. TaskMgr 

The TaskMgr is a Windows CE application, which provides real time info on all processes and 

threads including System threads, similar in appearance to the Windows Task Manager.  
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3.4. VCEP 

ICP DAS VCEP is designed for managing your VP-x231-CE7 anywhere. No matter where you are, ICP 

DAS VCEP provides a convenient environment on the Desktop PC and lets you control your 

VP-x231-CE7 remotely. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ICP DAS VCEP is composed of two main components: The Server which runs on VP-x231-CE7 and 

the Client which runs on a Desktop PC.  

 

Once a connection is established between the client and server (initiated by the client), the client 

will periodically send requests for screen updates and send mouse/key click information to the 

server to simulate.  

 

Each video frame is inter-compressed against the previous frame and then intra-compressed with a 

modified LZW scheme to minimize the amount of data transmitted from server to client. 

 

For more detailed information on VCEP application, please refer to 

http://ftp.icpdas.com.tw/pub/cd/winpac_am335x/VP-x231-CE7/pc_tools/vcep/ 

 

 

http://ftp.icpdas.com.tw/pub/cd/winpac_am335x/wp-9000/pc_tools/vcep/
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3.5. Remote_Display 

The Remote Display allows VP-x231-CE7 to be controlled and monitored from a remote location.  

 

This tool is composed of two parts, a client and a server. The server is a program named 

cerdisp.exe running on VP-x231-CE7. The client is a PC-based program named cerhost.exe running 

on the PC. 

 

 

 

 

Once a connection is established between the client and server (initiated by the client), the client 

will periodically send requests for screen updates and send mouse/key click information to the 

server to simulate.  
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3.6. SendToCOM 

The SendToCOM uses the serial port to communicate with expansion module. To use the 

SendToCOM, you can send data to expansion module through the serial port, and receive data 

from other device through the serial port. 

 

For more information about these commands for communicating with expansion module, please 

refer to: 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.

html#b 

 

 

http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html#b
http://www.icpdas.com/root/product/solutions/remote_io/rs-485/i-8k_i-87k/i-8k_i-87k_selection.html#b
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3.7. RegEdit 

The RegEdit provides a hierarchical representation of the registry on a target computer, similar in 

appearance to the Windows Registry Editor. The standard registry roots are represented; you can 

add keys beneath a root to point to existing registry keys, or you can add your own keys. Values can 

be changed for existing keys, or added for new keys, and default keys can be specified. For more 

information, see Registry Settings Management in Deployment. 
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3.8. ISQLW35 

The ISQLW35 is a Windows Embedded Compact 7 functionality that implements SQL Server 

Compact 3.5 Query. 
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3.9. INotepad 

The INotepad is a common text-only editor. The resulting files have no format tags or styles. 
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4. Your First VP-x231-CE7 Program 

This chapter provides a guided tour that describes the steps needed to set-up a development 

environment, download, install, configure for user programming with VP-x231-CE7 modules. 

 

 

 

4.1. Setting up the Development Environment 

Before writing your first program, ensure that you have the necessary development tool and the 

corresponding SDKs are installed on your system. 
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4.1.1. Preparing the Development Tools and Programming Languages 

VP-x231-CE7 is a Windows CE-based device that supports three programming languages for 

developing Windows CE applications. 

 

● Visual Basic.NET 

● Visual C# 

● Visual C++ 

 

Development Tools 

VP-x231-CE7 supports the application development with the Professional Edition application of 

Visual Studio 2008. 

 

 

 

 

 

 

 

 

Tips & Warnings 

There are some updates for Visual Studio 2008 to provide support for 

Windows Embedded Compact 7.  

If you have Professional Edition of Visual Studio 2008 are installed, make 

sure all of the following package are installed 

1. Visual Studio 2008 Service Pack 1 

http://www.microsoft.com/en-us/download/details.aspx?id=10986 

2. Visual Studio 2008 update for Windows Embedded Compact 7 

http://www.microsoft.com/en-us/download/confirmation.aspx?id=11935 

3. Windows Embedded Compact 7 ATL Update for Visual Studio 2008 SP1 

http://support.microsoft.com/kb/2468183/en-us 

 

 

http://www.microsoft.com/en-us/download/details.aspx?id=10986
http://www.microsoft.com/en-us/download/confirmation.aspx?id=11935
http://support.microsoft.com/kb/2468183/en-us
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4.1.2. Installing the VP-x231-CE7 SDK 

The VP-x231-CE7 SDK offers several APIs for customizing the standard features and integrating with 

other applications, devices and services. 

 

Step 1: Get the latest version of the VP-x231-CE7 SDK, AM335x_WINCE7_SDKV100B03  

The VP-x231-CE7 SDK can be found from the CD that was provided with the package 

or by downloading the latest version from ICP DAS web site. 

CD:\VP-x231\SDK\PlatformSDK\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/platformsdk/ 

 

Step 2: Execute the AM335x_WINCE7_SDK_YYYYMMDD.msi 

Follow the prompts until the installation process is complete. 

 

Step 3: Execute the VisualStudioDeviceWindowsEmbeddedCompact7 

Follow the prompts until the installation process is complete. 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/platformsdk/
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4.2. First VP-x231-CE7 Program in VB.NET 

The best way to learn programming with VP-x231-CE7 is to actually create a VP-x231-CE7 program.  

 

The example below demonstrates how to create a demo program running on VP-x231-CE7 with 

VB.NET. 

 

To create a demo program with VB.NET that includes the following main steps: 

 

1. Create a new project 

2. Specify the path of the PAC reference 

3. Add the control to the form 

4. Add the event handling for the control 

5. Upload the application to VP-x231-CE7 

6. Execute the application on VP-x231-CE7 

 

All main steps will be described in the following subsection. 

 

In this tutorial, we will assume that you have installed VP-x231-CE7 SDK on PC and used the Visual 

Studio 2008 for application development. 
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4.2.1. Create a new project 

The Visual VB.net project template is a composite control that you use in this example creates a 

new project with this user control. 

 

 

Step 1: Start Visual Studio 2008 

 

 

 

Step 2: On the File menu, point to New, and then click Project 
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Step 3: In the Project types pane, expand Visual Basic node and select Smart Device 

Step 4: In the list of Templates, select Smart Device Project 

Step 5: Specify a name and a location for the application and then click OK 
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Step 6: In the Target platform, select Windows CE 

Step 7: In the .NET Compact Framework version, select .NET Compact Framework 
Version 3.5.  

 

Tips & Warnings 

Windows CE7 only supports .NET Compact Framework Version 3.5, if your 

application uses .NET Compact Framework Version 2.0 there is no guarantee 

that the program will function correctly. 

 

 

Step 8: In the list of templates, select Device Application. Click OK 
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4.2.2. Specify the path of the PAC reference 

The PAC SDK provides a complete solution to integrate with VP-x231-CE7 and it’s compatible with 

Visual C#, Visual Basic.NET and C++. In order to use a component in your application, you must first 

add a reference to it. 

 

 

Step1: Get the PACNET.dll 

 

 

 

The PACNET.dll can be found from the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\VP-x231\SDK\PACNET\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/pacnet/ 

 

Step 2: On the Project menu, and then click Add Reference… 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/pacnet/
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Step 3: On the Browse tab and browse to where the PACNET.dll are installed, and then 
click OK 
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4.2.3. Add the control to the form 

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; 

they are just images that are convenient to move around on the form into a precise location. 

 

After you add a control to your form, you can use the Properties window to set its properties, such 

as background color and default text. The values that you specify in the Properties window are the 

initial values that will be assigned to that property when the control is created at run time. 

 

 

Step 1: On the Toolbox panel, drag a Button control onto the form 
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Step 2: On the Properties panel, type Check the SDK version in the Text field 
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4.2.4. Add the event handling for the control 

You have finished the design stage of your application and are at the point when you can start 

adding some code to provide the program's functionality. 

 

 

Step 1: Double-click the button on the form 

 

 

 

 

 

 

 

Step 2: Inserting the following code 

 

Dim data(30) As Byte 

PACNET.Sys.GetSDKVersion(data) 

MessageBox.Show(PACNET.MISC.WideString(data)) 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

The “PACNET” of “using PACNET” is case- sensitive. 
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4.2.5. Upload the application to VP-x231-CE7 

VP-x231-CE7 supports FTP server service. You can upload files to VP-x231-CE7 or download files 

from a public FTP server. 

 

 

 
 

 

 

 

 

 

Step 1: On the Build menu, and then click Build [Project Name] 
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Step 2: Open the browser and type the IP address of VP-x231-CE7 

 

Step 3: Upload the application and the corresponding PACNET.dll files to VP-x231-CE7 

 

 

Tips & Warnings 

For applications programming in C# and VB.net with .net compact 

framework, when executing these application on VP-x231-CE7, the 

corresponding PACNET.dll must be in the same directory as the .exe file. 
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4.2.6. Execute the application on VP-x231-CE7 

After uploading the application to VP-x231-CE7, you can just double-click it on VP-x231-CE7 to 

execute it. 
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4.3. First VP-x231-CE7 Program in Visual C# 

The best way to learn programming with VP-x231-CE7 is to actually create a VP-x231-CE7 program.  

 

The example below demonstrates how to create a demo program running on VP-x231-CE7 with 

Visual C#. 

 

To create a demo program with Visual C# that includes the following main steps: 

 

1. Create a new project 

2. Specify the path of the PAC reference 

3. Add the control to the form 

4. Add the event handling for the control 

5. Upload the application to VP-x231-CE7 

6. Execute the application on VP-x231-CE7 

 

All main steps will be described in the following subsection. 

 

In this tutorial, we will assume that you have installed VP-x231-CE7 SDK on PC and used the Visual 

Studio 2008 for application development. 
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4.3.1. Create a new project 

The Visual C# project template is a composite control that you use in this example creates a new 

project with this user control. 

 

 

Step 1: Start Visual Studio 2008 

 

 

 

Step 2: On the File menu, point to New, and then click Project 
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Step 3: In the Project types pane, expand Visual C# node and select Smart Device 

Step 4: In the list of Templates, select Smart Device Project 

Step 5: Specify a name and a location for the application and then click OK 
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Step 6: In the Target platform, select Windows CE 

Step 7: In the .NET Compact Framework version, select .NET Compact Framework 
Version 3.5.  

 

Tips & Warnings 

Windows CE7 only supports .NET Compact Framework Version 3.5, if your 

application uses .NET Compact Framework Version 2.0 there is no guarantee 

that the program will function correctly. 

 

 

Step 8: In the list of templates, select Device Application. Click OK 
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4.3.2. Specify the path of the PAC reference 

The PAC SDK provides a complete solution to integrate with VP-x231-CE7 and it’s compatible with 

Visual C#, Visual Basic.NET and C++. In order to use a component in your application, you must first 

add a reference to it. 

 

 

Step1: Get the PACNET.dll 

 

 

 

The PACNET.dll can be found from the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\VP-x231\SDK\PACNET\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/pacnet/ 

 

Step 2: On the Project menu, and then click Add Reference… 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/pacnet/
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Step 3: On the Browse tab and browse to where the PACNET.dll are installed, and then 
click OK 

 

 
 

 

 

 

 

 



VP-x231-CE7 User Manual, v1.0.2                    Page: 95 

Copyright ©  2017 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 
 

4.3.3. Add the control to the form 

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; 

they are just images that are convenient to move around on the form into a precise location. 

 

After you add a control to your form, you can use the Properties window to set its properties, such 

as background color and default text. The values that you specify in the Properties window are the 

initial values that will be assigned to that property when the control is created at run time. 

 

 

Step 1: On the Toolbox panel, drag a Button control onto the form 
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Step 2: On the Properties panel, type Check the SDK version in the Text field 
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4.3.4. Add the event handling for the control 

You have finished the design stage of your application and are at the point when you can start 

adding some code to provide the program's functionality. 

 

 

Step 1: Double-click the button on the form 

 

 

 

 

 

 

Step 2: Inserting the following code 

 

byte[] data = new byte[30]; 

PACNET.Sys.GetSDKVersion(data); 

MessageBox.Show(PACNET.MISC.WideString(data)); 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

The “PACNET” of “using PACNET” is case- sensitive. 
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4.3.5. Upload the application to VP-x231-CE7 

VP-x231-CE7 supports FTP server service. You can upload files to VP-x231-CE7 or download files 

from a public FTP server. 

 

 

 
 

 

 

 

 

 

Step 1: On the Build menu, and then click Build [Project Name] 
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Step 2: Open the browser and type the IP address of VP-x231-CE7 

 

Step 3: Upload the application and the corresponding PACNET.dll files to VP-x231-CE7 

 

 

Tips & Warnings 

For applications programming in C# and VB.net with .net compact 

framework, when executing these application on VP-x231-CE7, the 

corresponding PACNET.dll must be in the same directory as the .exe file. 
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4.3.6. Execute the application on VP-x231-CE7 

After uploading the application to VP-x231-CE7, you can just double-click it on VP-x231-CE7 to 

execute it. 
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4.4. First VP-x231-CE7 Program in Visual C++ 

The best way to learn programming with VP-x231-CE7 is to actually create a VP-x231-CE7 program.  

 

The example below demonstrates how to create a demo program running on VP-x231-CE7 with 

Visual C++. 

 

To create a demo program with Visual C# that includes the following main steps: 

 

1. Create a new project  

2. Configure the Platform 

3. Specify the path of the PAC reference 

4. Add the control to the form 

5. Add the event handling for the control 

6. Upload the application to VP-x231-CE7 

7. Execute the application on VP-x231-CE7 

 

All main steps will be described in the following subsection. 

 

In this tutorial, we will assume that you have installed VP-x231-CE7 SDK on PC and used the Visual 

Studio 2008 for application development. 
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4.4.1. Create a new project 

The Visual C# project template is a composite control that you use in this example creates a new 

project with this user control. 

 

 

Step 1: Start Visual Studio 2008 

 

 

 

Step 2: On the File menu, point to New, and then click Project 
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Step 3: In the Project types pane, expand Visual C++ node and select Smart Device 

Step 4: In the list of Templates, select MFC Smart Device Application 

Step 5: Specify a name and a location for the application and then click OK 
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Step 6: On the first page of the wizard, click Next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 7: On the next page of the wizard, select AM335x_WINCE7_SDK to be added to the 
project, and then click Next 
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Step 8: On the next page of the wizard, select Dialog based, and then click next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 9: On the next page of the wizard, click next 
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Step 10: On the next page of the wizard, click next 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 11: On the next page of the wizard, click Finish 
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4.4.2. Configure the Platform 

When developing applications by using Visual C++, you must configure the Platform to indicate 

what platform and device you intend to download the application to. Before you deploy your 

project, check the platform. 

 

On the Debug configuration toolbar, select Release and select AM335x_WINCE7_SDK(ARMv4I) as 

shown in the following illustration. 
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4.4.3. Specify the Path of PACSDK library and header files 

The PAC SDK provides the PACSDK library and header files with VP-x231-CE7. 

It’s compatible with C++. In order to use a component in your application, you must first add a 

reference to it. 

 

 

Step 1: On the View menu, and then click Property Pages 
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Step 2: In left pane, expand Configuration Properties, and then click C/C++ 

Step 3: In the right pane, choose the following path in the Additional Include 
Dependencies item 

C:\Program Files\Windows CE Tools\SDKs\N2000_WINCE7_SDK\Include\Armv4i 

C:\Program Files\Microsoft Visual Studio 9.0\VC\atlmfc\include 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: In the right pane, choose the following path in the “Additional Include Directories” 
item 
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Step 4: In left pane, click Linker 

Step 5: In the right pane, choose the following path in the Additional Library 
Dependencies item 

C:\Program Files\Windows CE Tools\SDKs\N2000_WINCE7_SDK\Include\Armv4i 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: In the right pane, choose the following path in the “Additional Include Directories” 
item 
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4.4.4. Add the control to the form 

You can drag various controls from the Toolbox onto the form. These controls are not really "live"; 

they are just images that are convenient to move around on the form into a precise location. 

 

After you add a control to your form, you can use the Properties window to set its properties, such 

as background color and default text. The values that you specify in the Properties window are the 

initial values that will be assigned to that property when the control is created at run time. 

 

 

Step 1: On the View menu, and then click Resource View 
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Step 2: In the Resource View Panel, Expand the [Project name].rc file and then expand 
the Dialog item to click the plug-in dialog 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 3: On the Toolbox panel, drag a Button control onto the form 
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Step 4: On the Properties panel, type Check the SDK version in the Caption field 
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4.4.5. Add the event handling for the control 

You have finished the design stage of your application and are at the point when you can start 

adding some code to provide the program's functionality. 

 

 

Step 1: Double-click the button on the form 

 

 

 

 

 

 

 

 

 

 

 

Step 2: Inserting the following code 

char sdk_version[32]; 

TCHAR buf[32]; 

pac_GetSDKVersion(sdk_version); 

pac_AnsiToWideString(sdk_version, buf); 

MessageBox(buf,0,MB_OK); 
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Step 2: Inserting the following code into the header area 

#include “PACSDK.h” 
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4.4.6. Upload the application to VP-x231-CE7 

VP-x231-CE7 supports FTP server service. You can upload files to VP-x231-CE7 or download files 

from a public FTP server. 

 

 

 
 

 

 

 

 

 

Step 1: On the Build menu, and then click Build [Project Name] 
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Step 2: Open the browser and type the IP address of VP-x231-CE7 

 

Step 3: Upload the application to VP-x231-CE7 
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4.4.7. Execute the application on VP-x231-CE7 

After uploading the application to VP-x231-CE7, you can just double-click it on VP-x231-CE7 to 

execute it. 
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5. I/O Expansion Modules and SDKs Selection 

This chapter describes how to select a suitable expansion I/O module and the corresponding SDK 

library to be used for developing programs on VP-x231-CE7. 

 

VP-x231-CE7 provides the following I/O expansion buses: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ET-7K ET-87Pn 

M-7K RU-87Pn I-7K 

Local I/O modules 
(I-8K/I-87K series I/O modules) 

 

 

I/O Slots 

RS-485 
Ethernet 

 
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1. Local I/O Modules (I-8K series and I-87K series) 

VP-x231-CE7 has three expansion slots that can be used to add expansion I/O modules. The 

expansion I/O modules can be divided into two categories: High Profile I-8K series I/O modules and 

High profile I-87K series I/O modules. The following indicates the appropriate SDK library to be 

used for I/O modules. 

 

 General I-8K/I-87K series I/O modules 

Module Native SDK .NET CF SDK 

I-8K series PACSDK.dll PACNET.dll 

I-87K series PACSDK.dll PACNET.dll 

I-8K series with PWM PACSDK_PWM.dll PACNET.dll 

I-87K series with PWM PACSDK_PWM.dll PACNET.dll 

 

For full details regarding I-87K series I/O modules and its demos, please refer to: 

http://ftp.icpdas.com/pub/cd/winpac_am335x/demo/vp-x231/pac/applicabled_demo_for_87k_m

odule.pdf 

 

 

 Specified I-8K series I/O modules 

Module Native SDK .NET CF SDK 

I-8014W pac_i8014W.dll pac_i8014WNET.dll 

I-8017HW pac_i8017HW.dll pac_i8017HWNET.dll 

I-8024W pac_i8024W.dll pac_i8024WNET.dll 

I-8026W pac_i8026W.dll pac_i8026WNET.dll 

I-8048W pac_i8048W.dll pac_i8048WNET.dll 

I-8050W pac_i8050W.dll pac_i8050WNET.dll 

I-8084W pac_i8084W.dll pac_i8084WNET.dll 

I-8088W pac_i8088W.dll pac_i8088WNET.dll 

I-8093W pac_i8093W.dll pac_i8093WNET.dll 

I-87088W PACSDK_PWM.dll PACNET.dll 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/demo/vp-x231/pac/applicabled_demo_for_87k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/demo/vp-x231/pac/applicabled_demo_for_87k_module.pdf
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2. RS-485 (I-7000 series and M-7000 series) 

I-7000, M-7000, RU-87Pn and high profile I-87K series modules connect to VP-x231-CE7 via a 

twisted-pair, multi-drop, 2-wire RS-485 network. 

 

 I-7000 series I/O modules 

Module Native SDK .NET CF SDK 

I-7000 series PACSDK.dll PACNET.dll 

I-7000 series with I-7088 (D) PACSDK_PWM.dll PACNET.dll 

 

For full details regarding I-7000 series I/O modules and its demos, please refer to: 

http://ftp.icpdas.com/pub/cd/winpac_am335x/demo/vp-x231/pac/applicabled_demo_for_7k_mo

dule.pdf 

 

 

 M-7000 series I/O modules 

Module Native SDK .NET CF SDK 

M-7000 series Modbus Demo Modbus Demo 

 

For more detailed information about M-7000 series modules using Modbus protocol and its demos, 

please refer to: 

CD:\vp-x231\demo\nModbus\ 

 

 

 RU-87Pn + I-87K series I/O modules 

Module Native SDK .NET CF SDK 

RU-87Pn+I-87K series PACSDK.dll PACNET.dll 

 

 

 Other Specified I/O 

Module Native SDK .NET CF SDK 

Others PACSDK.dll PACNET.dll 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/demo/vp-x231/pac/applicabled_demo_for_7k_module.pdf
http://ftp.icpdas.com/pub/cd/winpac_am335x/demo/vp-x231/pac/applicabled_demo_for_7k_module.pdf
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3. Ethernet (ET-7000 series and I-8KE4/8-MTCP) 

The Ethernet I/O devices available include ET-7000and I-8KE4/8-MTCP, and support either the 

DCON or the Modbus/TCP communication protocol. 

 

Module Native SDK .NET CF SDK 

M-7000 series Modbus Demo Modbus Demo 

I-8KE4/8-MTCP Modbus Demo Modbus Demo 

 

For more detailed information about ET-7000 and I-8KE4/8-MTCP series modules using 

Modbus protocol and its demos, please refer to: 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/nmodbus/ 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/nmodbus/
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6. API Resources and Demo References 

This chapter provides a brief overview of PAC standard APIs and demos that have been designed 

for VP-x231-CE7 from the PAC SDK package. 

 

 

ICP DAS provides a set of demos in different programming languages. You can examine the demo 

codes, which includes numerous comments, to familiarize yourself with the PAC APIs. This will 

allow developing your own applications quickly by modifying these demo programs. 

 

For full usage information regarding the description, prototype and the arguments of the functions, 

please refer to the “PAC Standard API Manual” 
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6.1. PAC Standard APIs for System Operation 

The diagram below shows the set of each system operation API provided in the PACSDK. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

System Operation 

 System Information 

 Backplane Access 

 Backlight 

 Interrupt 

 Memory Access 

 Watchdog 

 UART 

 Registry 

 Buzzer 

 LED 
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6.1.1. VB.NET Demos for PAC Standard APIs 

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a 

VB.NET language environment.  

 

The following demos can be found on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\vp-x231\Demo\PAC\Vb.net\Standard\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vb.net/standard/ 

 

Folder Demo Explanation 

system systeminfo 
Retrieves information about the OS version, CPU 

version, SDK version, etc. 

backplane backplaneinfo 
Retrieves information about the DIP switch, backplane 

ID and slot count. 

memoryaccess 
memory 

Shows how to read/write date values from/to 

EEPROM 

battery_backup_sram Shows how to read or write to the battery backup 

watchdog watchdog Displays how the watchdog operate 

microsd microsd_management Shows how to enables/disables Micro SD 

registry registry Shows how to read/write date values from/to registry 

UART diag 
Shows how to read the name of local I/O modules via 

UART 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vb.net/standard/
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6.1.2. C# Demos for PAC Standard APIs 

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a 

C# language environment.  

 

The following demos can be found on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\ vp-x231\Demo\PAC\C#\Standard\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/c%23/standard/ 

 

Folder Demo Explanation 

buzzer buzzer Shows how to make a simple buzzer beep. 

DeviceInformation DeviceInformation 
Retrieves information about the OS version, CPU 

version, SDK version, etc. 

GetRotaryID GetRotaryID 
Retrieves information about the status of the 

rotary switch 

Memory Memory 
Shows how to read/write data values from/to 

the EEPROM or the backplane of the SRAM 

MultiRT MultiRT Shows how to manage the microSD 

RealTimeTest RealTimeTest 

Writes the managed cod for the rich graphical 

user interface that does not require true 

real-time performance 

Registry Registry 
Shows how to read/write data values from/to 

the registry 

UART UART 
Shows how to read the name of a local I/O 

modules via a UART 

WatchDog WatchDog 
Displays information about how to operate the 

watchdog 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/c%23/standard/
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6.1.3. Visual C++ Demos for PAC Standard APIs 

The PAC SDK includes the following demos that demonstrate the use of the PAC Standard APIs in a 

Visual C++ language environment.  

 

The following demos can be found on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\ vp-x231\Demo\PAC\Vc2008\Standard\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vc2008/standard/ 

 

Folder Demo Explanation 

buzzer buzzer Shows how to make a simple buzzer beep. 

DeviceInformation DeviceInformation 
Retrieves information about the OS version, CPU 

version, SDK version, etc. 

GetRotaryID GetRotaryID 
Retrieves information about the status of the 

rotary switch 

Memory Memory 
Shows how to read/write data values from/to 

the EEPROM or the backplane of the SRAM 

MultiRT MultiRT Shows how to manage the microSD 

RealTimeTest RealTimeTest 

Writes the managed cod for the rich graphical 

user interface that does not require true 

real-time performance 

Registry Registry 
Shows how to read/write data values from/to 

the registry 

UART UART 
Shows how to read the name of a local I/O 

modules via a UART 

WatchDog WatchDog 
Displays information about how to operate the 

watchdog 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vc2008/standard/
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6.2. PAC Standard APIs for I/O Expansion 

The diagram below shows the types of the PAC IO APIs provided in the PACSDK. 
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Remote I/O Local I/O 
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6.2.1. VB.NET Samples for PAC Standard APIs 

The PAC SDK includes the following samples that demonstrate the use of the PAC IO APIs in a 

VB.NET language environment. The following samples can be found on the CD that was provided 

with the package or by downloading the latest version from ICP DAS web site. 

For VB.NET applications, these demo programs can be obtained from: 

CD:\vp-x231\Demo\PAC\Vb.net\IO\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vb.net/io/ 

 

 

Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module names and types which 

plugged in the VP-x231-CE7. 

8k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 8K series DI modules. 

8k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 8K series DO modules. 

8k_dio 
Shows how to read the DI and the DO values of the DIO module.  

This demo program is used by 8K series DIO modules. 

87k_basic 
Shows how to send/receive a command/response application. 

This demo program is used by 87K series modules. 

87K_demo 
Shows how use UART API and the IO modules located as slots.  

This demo program is used by 87K series modules. 

87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 87K series AI modules. 

87k_ao 
Shows how to write the AO values to AO module. 

This demo program is used by 87K series AO modules. 

87k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 87K series DI modules. 

87k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 87K series DO modules. 

87k_dio 
Shows how to read the DI and the DO values of the DIO module. 

This demo program is used by 87K series DIO modules. 

Remote 

7k87k_basic 

Shows how to send/receive a command/response application. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 7K or 87K series  

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vb.net/io/
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Folder Demo Explanation 

AI modules which connected through a COM port. 

7k87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of the DIO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 
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6.2.2. C# Samples for PAC Standard APIs 

The PAC SDK includes the following samples that demonstrate the use of the PAC IO APIs in a C# 

language environment. The following samples can be found on the CD that was provided with the 

package or by downloading the latest version from ICP DAS web site. 

For C# applications, these demo programs can be obtained from: 

CD:\vp-x231\Demo\PAC\C#\IO\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/c%23/io/ 

 

 

Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module names and types which 

plugged in the VP-x231-CE7. 

8k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 8K series DI modules. 

8k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 8K series DO modules. 

8k_dio 
Shows how to read the DI and the DO values of the DIO module.  

This demo program is used by 8K series DIO modules. 

87k_basic 
Shows how to send/receive a command/response application. 

This demo program is used by 87K series modules. 

87K_demo 
Shows how use UART API and the IO modules located as slots.  

This demo program is used by 87K series modules. 

87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 87K series AI modules. 

87k_ao 
Shows how to write the AO values to AO module. 

This demo program is used by 87K series AO modules. 

87k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 87K series DI modules. 

87k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 87K series DO modules. 

87k_dio 
Shows how to read the DI and the DO values of the DIO module. 

This demo program is used by 87K series DIO modules. 

Remote 

7k87k_basic 

Shows how to send/receive a command/response application. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 7K or 87K series  

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/c%23/io/
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Folder Demo Explanation 

AI modules which connected through a COM port. 

7k87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of the DIO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 
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6.2.3. Visual C++ Samples for PAC Standard APIs 

The PAC SDK includes the following samples that demonstrate the use of the PAC IO APIs in a 

Visual C++ language environment. The following samples can be found on the CD that was 

provided with the package or by downloading the latest version from ICP DAS web site. 

For Visual C++ applications, these demo programs can be obtained from: 

CD:\vp-x231\Demo\PAC\Vc2008\IO\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vc2008/io/ 

 

 

Folder Demo Explanation 

Local 

find_io 
Shows how to retrieve the module names and types which 

plugged in the VP-x231-CE7. 

8k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 8K series DI modules. 

8k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 8K series DO modules. 

8k_dio 
Shows how to read the DI and the DO values of the DIO module.  

This demo program is used by 8K series DIO modules. 

87k_basic 
Shows how to send/receive a command/response application. 

This demo program is used by 87K series modules. 

87K_demo 
Shows how use UART API and the IO modules located as slots.  

This demo program is used by 87K series modules. 

87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 87K series AI modules. 

87k_ao 
Shows how to write the AO values to AO module. 

This demo program is used by 87K series AO modules. 

87k_di 
Shows how to read the DI values of DI module. 

This demo program is used by 87K series DI modules. 

87k_do 
Shows how to write the DO values to DO module. 

This demo program is used by 87K series DO modules. 

87k_dio 
Shows how to read the DI and the DO values of the DIO module. 

This demo program is used by 87K series DIO modules. 

Remote 

7k87k_basic 

Shows how to send/receive a command/response application. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_ai 
Shows how to read the AI values of AI module. 

This demo program is used by 7K or 87K series  

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/demo/pac/vc2008/io/
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Folder Demo Explanation 

AI modules which connected through a COM port. 

7k87k_ao 

Shows how to write the AO values to AO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_di 

Shows how to read the DI values of DI module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_do 

Shows how to write the DO values to DO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 

7k87k_dio 

Shows how to read the DI and the DO values of the DIO module. 

This demo program is used by 7K or 87K series  

AI modules which connected through a COM port. 
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7. VP-x231-CE7 Updates 

This chapter provides a guided tour that demonstrates the steps needed to update the 

VP-x231-CE7 OS and SDKs. 

 

ICP DAS will continue to add additional features to VP-x231-CE7 SDK and OS in the future, so we 

advise you to periodically check the ICP DAS web site for the latest updates. 

 

 

The file location of the OS and SDK 

Both the files of OS updates and SDK updates can be found on the CD that was provided with the 

package or by downloading the latest version from ICP DAS web site. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The files of SDK updates 

CD:\vp-x231\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/ 

OS_Image 

VP-123x 

update_from_Micro_SD 

update_from_file 

SDK 

Modbus 

nModbus 

PACNET 

PACSDK 

PlatformSDK 

The files of OS updates 
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7.1. OS Updates 

The latest version of the VP-x231-CE7 OS image can be found separately on the CD that was 

provided with the package or by downloading the latest version from ICP DAS web site. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

There are two ways to update the OS: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. OS updates from eshell (Please refer to section 7.1.1) 

(We recommend that you use this one for more quicker and easier to update) 

2. OS updates from micro_SD (Please refer to section 7.1.2) 

 

 

CD:\vp-x231\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/ 

OS_Image 

VP-123x 

update_from_Micro_SD 

update_from_file 

OS image 

update_from _file 
update_from_Eshell_

or_Micro_SD 

 LAN 
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7.1.1. OS Updates from Eshell 

 

By default, the OS update is updated via a LAN. 

Before updating the OS, make sure the LAN is 

connected to PC. 

 

 

Step 1: Get the latest version of the installation package file and then unzip it 

The latest version of the installation package file can be found from ICP DAS web site. 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/os_image/vp-123x/update_f

rom_eshell_or_micro_sd\ 

 

Step 2: Run the registry clear.exe 

The registry.exe can be found on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

CD:\VP-x231\PC_Tools\Eshell 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/pc_tools/eshell/ 

 

Step 3: Place the rotary switch in position 3, OS update mode 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 LAN 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/os_image/vp-123x/update_from_eshell_or_micro_sd/
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/os_image/vp-123x/update_from_eshell_or_micro_sd/
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/pc_tools/eshell/
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Step 4: Run the ESHELL.exe, and then restart the VP-x231-CE7-CE7 

The ESHELL.exe can be found on the CD that was provided with the 

package or by downloading the latest version from ICP DAS web site. 

CD:\VP-x231\PC_Tools\Eshell 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/pc_tools/eshell/ 

 

Step 5: Select the device which you want to update the OS image, and then click OK 

Select the device name which you want to update the OS image from the list. 

 

 

 

 

 

 

 

 

 

 

Step 6: Select the latest version of the OS image file 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/pc_tools/eshell/
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Step 7: Once the procedure is completed, the “Warning !” dialog box will appear as 
below shown, then turn the rotary switch in position 0, normal mode 

 

 

 

 

 

 

 

Step 8: Click the OK button 

 

 

 

 

 

 

 

Step 9: Check the OS version 

Run the PAC Utility, and then select the Device Information tab to check the current 

OS version. 
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7.1.2. OS updates using micro_SD 

The microSD card can be used to reinstall the VP-x231-CE7 OS image to factory default settings in 

the event of the VP-x231-CE7 failure. 

 

 

Step 1: Get the latest version of the installation package file, then unzip the file, and then 
copy them to microSD card 

The latest version of the installation package file can be found from ICP DAS web site. 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/os_image/vp-123x/update_f

rom_eshell_or_micro_sd\ 

 

 

 

 

 

 

 

 

 

 

Step 2: Plug the microSD card into microSD slot 

 

 

 

 

 

 

 

 

 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/os_image/vp-123x/update_from_eshell_or_micro_sd/
http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/os_image/vp-123x/update_from_eshell_or_micro_sd/
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Step 3: Turn the rotary switch in position 5, 
OS update mode 

 

 

 

 

 

 

 

 

Step 4: Reboot the VP-x231-CE7 

 

 

 

 

 

 

Step 5: Wait a few minutes for the following 
desktop to be displayed 

 

 

 

 

 

 

 

Step 6: Turn the rotary switch in position 0, normal mode 
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Step 7: Reboot the VP-x231-CE7 

 

 

 

 

 

 

 

 

 

 

 

 

Step 8: Check the OS version 

Run the PAC Utility, and then select the Device Information tab to check the current 

OS version. 
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7.2. SDK Updates 

SDK update is a part of the VP-x231-CE7 update services to provide additional and more efficient 

features and functionality for VP-x231-CE7 operating system.  

 

The SDK update files can be found separately on the CD that was provided with the package or by 

downloading the latest version from ICP DAS web site. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

CD:\vp-x231\SDK\ 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/ 

Modbus 

nModbus 

PACNET 

PACSDK 

PlatformSDK 
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7.2.1. SDK Updates for VB.NET or C# 

The SDK can be updated by changing the SDK file. 

 

Step 1: Get the latest version of the PACNET.dll file 

The latest version of the PACNET.dll file can be obtained from ICP DAS web site. 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/pacnet/ 

Step 2: Copy the latest version of PACNet.dll file to PC and VP-x231-CE7 

The PACNET.dll file on PC can be placed anywhere only the solution can reference it. 

The PACNET.dll file on VP-x231-CE7 is located at the same directory as the .exe file. 

 

 

  

  

  

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/pacnet/
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7.2.2. SDK Updates for VB.NET or Visual C++ 

The SDK can be updated by changing the SDK file. 

 

 

Step 1: Get the latest version of the VC++ components 

The latest version of the VC++ components can be obtained from:  

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/pacsdk/ 

 

Step 2: Copy the latest version of header files and libraries to PC 

The header files are located at:  

C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Include\Armv4i 

The libraries are located at:  

C:\Program Files\Windows CE Tools\SDKs\AM335x_WINCE7_SDK\Lib\ARMv4I 

 

Step 3: Copy the latest version of DLL files to VP-x231-CE7 

The DLL files are located at:  

\System_Disk\ICPDAS\System 

 

 

 

http://ftp.icpdas.com/pub/cd/winpac_am335x/vp-x231/sdk/pacsdk/
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8. ViewPAC Download Center 

This chapter provides a brief introduction of the ViewPAC download center. 

 

ViewPAC has a download center where you can access the latest version of the software, tools, 

demo programs, and related information.  

 

The ViewPAC Download Center can be found at: 

http://www.icpdas.com/root/support/download/pac/vp-x23x-ce7/vp-x23x-ce7_download_os_ima

ges.html 
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Tips & How to 

This chapter provides tips and a guided tour on using and maintaining the VP-x231-CE7. 
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A. I-8K and I-87K I/O Modules 

There are 3 slots to expand local I/O. And the I/O modules can be parallel bus type (high profile 

I-8K series) and serial bus type (high profile I-87K series). 

 

The difference between them is as follows: 

 

Functions I-8K Series I-87K Series 

Communication interface Parallel bus Serial bus 

Protocol - DCON 

Communication speed Fast Slow 

DI latched function - Yes 

Counter input (for digital input module) - Yes (100 Hz) 

Power on value - Yes 

Safe value - Yes 

Programmable slew-rate for AO module - Yes 
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B. How to Change the Battery 

RTC and SRAM data is retained by two Li batteries, which can supply continuous power to the 512 

KB SRAM to ensure that the data is retained for 5 years. The dual-battery design has the added 

function of preventing data from being lost while replacing the battery. 

 

The following figures show the location of the two batteries installed in the ViewPAC. 

 

 

 

 

 

 

 

 

 

 

 

 

 

To checking the current battery power: 

1. Run the PAC utility and check the Battery1 and Battery2 fields that display the current 

status of each battery. Refer to Section 3.1.3. PAC Utility - Property Tab - General for more 

details. If the power level for either of the batteries is low, both should be replaced.  

2. When programming this, call the pac_GetBatteryLevel() API function in the PACSDK.dll to 

check whether the battery power is low. When the power for either of the batteries is low, 

it’s recommended that the battery is replaced immediately, otherwise the data on the 

SRAM may be lost or RTC time will be reset. 

 

Tips & Warnings 

The battery initial voltage should be around 2.8 V to 3.0 V. When lower than 

2.1 V, the PAC Utility will show the low power warning. When lower than 1.5 

V, the data in the RTC (real time clock) and 512 KB SDRAM will be lost. 
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To replace the battery without losing data: 

1. Power off the ViewPAC. 

2. Remove the slot cover and I/O socket inserted into the slot. 

3. First, remove the battery that is running low on power from the battery holder. 

4. Insert a new battery. 

5. Remove the other battery. 

6. Insert a new battery. 

 

Tips & Warnings 

1. If the battery power for only one of the two batteries is low, you can use 

this method to replace the battery so as to prevent data from being lost. (In 

the circuit design for the ViewPAC series, when the power for one of the 

batteries is low, it will automatically switch to the other one to ensure 

continued battery power) 

2. If both batteries have run out of power, the data will be lost, even if this 

method is used to replace the batteries. 

 

 

To replace the battery 1/2: 

To back up the SRAM data using the backup utility before replacing the battery. Refer to Section 

“Using the Backup Utility to back up the settings and files” to back up and restore the SRAM data. 

1. Run the backup utility to back up the SRAM data. 

2. Power off the ViewPAC. 

3. Remove the slot cover and I/O socket inserted into the slot. 

4. Remove both batteries from their respective holders. 

5. Insert a new battery. 

6. Power on the ViewPAC. 

7. Run the backup utility to restore the SRAM data. 

8. Set the RTC time. 
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C. How to Online Debug the VP-x231-CE7 Program 

Here are step by step instructions on how to online debug the VP-x231-CE7 program. 

 

Tips & Warnings 

Before starting online debug the VP-x231-CE7 program, make sure that the 

VP-x231-CE7 SDK has been installed correctly.  

For more information on how to install the VP-x231-CE7 SDK, please refer to 

4.1.2. Installing the VP-x231-CE7 SDK. 

 

 

Step 1: Copy the following files to the \System_Disk\icpdas\system on the VP-x231-CE7 

By default, these files are located on the development computer at C:\Program 

Files\Common Files\Microsoft Shared\CoreCon\1.0\Target\wce400\<CPU>. 

 clientshutdown.exe 

 CMAccept.exe 

 ConmanClient2.exe 

 eDbgTL.dll 

 TcpConnectionA.dll 

Step 2: Run the ConmanClient2.exe and then CMAccept.exe on the VP-x231-CE7 
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Step 3: On the Tools menu, click the Options 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: In the left pane, expand Device Tools node and select Devices 

Step 5: In the Show devices for platform:, select AM335x_WINCE7_SDK and then click 
Properties 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



VP-x231-CE7 User Manual, v1.0.2                    Page: 153 

Copyright ©  2017 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 
 

Step 6: Click the Configure… 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 7: Select the Use specific IP address:, and then type the IP address of VP-x231-CE7 
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Step 8: Click the OK, and then click OK to end the dialog 
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Step 9: On the Tools menu, click the Connect to Device… 

 

 

Step 10: Wait for the connection to be established 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

If the connection fails, as shown below, please repeat the step 2 to step 9 to 

try it again. 
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D. How to Automatically Synchronize VP-x231-CE7 Clock with an 
Internet Time Server 

The clock on the VP-x231-CE7 can be synchronized with an internet time server. This means that 

the clock is updated to match the clock on the time server, which can help ensure that the time on 

the VP-x231-CE7 is accurate. Here are step by step instructions on how to synchronize the clock on 

the VP-x231-CE7 with an Internet time server.  

 

 

Step 1: Run the PAC Utility 

 

 

 

 

Step 2: On the General tab, press Configure button 
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Step 3: Select the domain name from the Server drop-down list, and then enter a value 
in the Autoupdate Frequency field 

Step 4: Check the Automatically synchronize with an internet time server check box 

 

 

 

 

 

 

 

 

 

 

 

Step 5: On the File menu, click Save and Reboot 

 

 

 

 

 

 

 

 

 

 

Step 6: The VP-x231-CE7 will automatically synchronize with an internet time server 
regularly 

 

Step 7: Click the Update Now button to 
synchronize VP-x231-CE7 clock 
immediately 
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E. How to Control the User Account Control in VP-x231-CE7 

User Account Control is a security feature that helps prevent unauthorized system changes to the 

VP-x231-CE7. 
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E.1. How to Create a User Account 

Here are step by step instructions on how to add a user account. 

 

 

Step 1: Run the PAC Utility 

 

 

 

 

 

Step 2: On the Login tab of the Network tab, click Login tab, type the User Name and 
Password, and then click Add button 
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Step 3: The user has been added to the allowed under the remote login and included in 
the following list 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: On the File menu, click Save and Reboot for changes to take effect 
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E.2. How to Use Telnet to Remote Login the ViewPAC from PC 

Here are step by step instructions on how to use telnet to remote login the ViewPAC from PC. 

 

 

Step 1: On the PC, open a MS-DOS command prompt 

 

 

 

 

 

 

 

 

 

 

 

Step 2: At the command prompt, type “telnet (IP address)” 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Type “cmd” 

1 
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Step 3: The connection has been set up, and then type the name and password 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 4: The remote login has been completed 
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E.3. How to Remove a User Account from the Login List 

Here are step by step instructions on how to remote the user from the login list. 

 

 

Step 1: Click a user from the list which you want to remove, and the user will display in 
the field, and then press Delete to delete the user from the login list 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Step 2: On the File menu, click Save and Reboot for changes to take effect 
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F. How to Use the Services Tool 

The services tool can help you turn on, turn off and monitor the WinCE services. 

 

 

Step 1: On the PC, open a MS-DOS command prompt 

 

 

 

 

 

 

 

 

 

 

 

Step 2: List all services 

[Syntax] services list 

 

 

2. Type “cmd” 

1 
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Step 3: Type the commands to configure service  

[Syntax] services stop <services name> 

For example, turn on the “FTP” service: 

services stop FTP0: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Tips & Warnings 

For more information about using services tool, just type “services help” 
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G. Application of RS-485 Network 

The RS-485 length can be up to 4000 ft or 1.2 km over a single set of twisted–pair cables, if the 

RS-485 network is over 4000 ft or 1.2Km, the RS-485 repeater must be added to extend the RS-485 

network. 
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G.1. Basic RS-485 Network 

The basic component of the RS-485 network consist of a Master Controller (or using a PC as a host 

controller), and some RS-485 devices. 

 

Tips & Warnings 

If PC/Laptop has no COM port, you can use the I-7561 (USB to RS-485 

converter) for connection between ViewPAC and PC/Laptop. 

Before using the I-7561 converter, you must install the USB driver. The USB 

driver can be obtained from: 

ftp://ftp.icpdas.com/pub/cd/8000cd/napdos/7000/756x/   

 

 

 

 

 

ftp://ftp.icpdas.com/pub/cd/8000cd/napdos/7000/756x/


VP-x231-CE7 User Manual, v1.0.2                    Page: 168 

Copyright ©  2017 ICP DAS Co., Ltd. All Rights Reserved.   E-mail: service@icpdas.com 
 

G.2. Daisy Chain RS-485 Network 

All RS-485 devices are wired directly to the main network. If the network is up to 1.2 km, a 

repeater (7510 series) is required to extend the length of the network. 
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G.3. Star Type RS-485 Network 

There are branches along the main network. In this case, it is better to have a repeater to isolate or 

filter the noise that is made by devices. 
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There is a better choice to use 7513 as a RS-485 hub on start type network. 
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G.4. Random RS-485 Network 

There are branches along the main wire. In this case, it is better to have a repeater to isolate or 

filter the noise that is made by devices. 
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G.5. Master/Slaves Settings 

There must be exist one master to have a jumper in the same network. In a master/slave 

application, “Master” is the default configuration of ViewPAC. 
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G.5.1. ViewPAC as a Master (default) 

When one of ViewPAC is set to the master mode, then all the other devices on the same network 

must be set to the slave mode. 

Set ViewPAC to the master mode by adjusting the jumpers on the PCB board of ViewPAC. Refer to 

the following figure: 
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G.5.2. ViewPAC as a Slave: 

Set ViewPAC to the slave mode by adjusting the jumpers on the PCB board of ViewPAC. Refer to 

the following figure: 
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The maximum distance of RS-485 without using a repeater is 1,200 meters (4,000 feet). You can 

extend that distance by adding an RS-485 Repeater every 1,200 meters as shown below. 
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G.6. 120Ω Terminating Resistor Settings 

The built-in 120Ω terminating resistor is for RS-485 network communication, and is disabled as 

factory default setting. If the total length of the communication bus longer than 100 m, 

terminating resistors is recommended to be placed at both far ends of the cable.  
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 RS-485 bus < 100m 
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 RS-485 bus > 100m 
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H. Revision History 

This chapter provides revision history information to this document. 

 

The table below shows the revision history. 

 

Revision Date Description 

1.0.0 December 2015 Initial issue 

1.0.1 May 2016 Added the product information about VP-4231-CE7 

and VP-6231-CE7. 

1.0.2 December 2016 Modified the installation information in section 

2.1.1, 2.1.2. and 2.1.3. 
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